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Introduction
Overview
EC-Math is a program that automates column summary in Ecco. More specifically, EC-Math will calculate the 
total, minimum, maximum, average or weighted average of detail item values and put the summary in the 
parent item. Specific examples include totaling hours, finding the earliest start date, finding the latest finish date
and averaging test scores. Once you define the operations you want to execute, you only have to click on an 
icon to update the values.

License Agreement
Shareware
This product is distributed under the shareware marketing concept. This means that you try the program for a 
limited amount of time to see if it meets your needs. After the trial period, you are required to register and pay 
the registration fee or to stop using it.

Shareware is a distribution method, NOT a type of software. The primary difference between shareware and 
retail software is that with shareware you know if it fits your needs BEFORE you pay for it.

The shareware system and the continued availability of quality shareware products depend on your willingness 
to register and pay for the shareware you use. It's the registration fees you pay which allow us to support and 
continue to develop our products. Please show your support for shareware by registering those programs you 
actually use and by passing them on to others.

License
Nonregistered users are granted a limited license to try EC-Math for a period of 30 days. After the trial period 
you are required to register and to pay the registration fee or stop using it. The 30 day evaluation period is a 
legal requirement based on the license agreement. EC-Math will not stop working or cause any damage to 
itself or your system at the end of the 30 dayperiod.

Registration grants a user the right to use EC-Math only on a single computer. If that user uses the computer at
least 80% of the time the computer is in use, then that person may also use EC-Math on his or her home or 
laptop computer.

No one may modify EC-Math in any way, including but not limited to decompiling, disassembling or otherwise 
reverse engineering the program.

All users are granted a limited license to copy EC-Math only for the trial use of others subject to the above 
limitations, and also the following:
• EC-Math and acompanying documentation must be copied in unmodified form, complete with the file 

containing license and ordering information,
• The full EC-Math documentation must be included with the copy, and
• No fee, charge or other compensation may be accepted or requested by any licensee except a minimal 

charge to cover distribution costs.

Operators of electronic bulletin board systems (Sysops) may post EC-Math    for downloading by their users 
only as long as the above conditions are met.

Warranty
Use of this software for any purpose whatsoever constitutes your unqualified acceptance of the following 
statements.

The author makes no warranty or representation that the software will be error free. The author disclaims any 
warranties, either express or implied, including but not limited to any implied warranty of merchantability or 
fitness for any particular purpose.

The user agrees to take full responsibility for the selection of and any use whatsoever made of the software.



In no event will the author be liable for any damages whatsoever (including, without limitation, damages for loss
of business profits, business interruption, loss of business information or the like) arising out of the use of, 
interruption in the use of, or inability to use this software, even if the author has been advised of any possibility 
or likelihood of such damages.

Copyright/Trademarks
EC-Math program and documentation copyright © 1994 by Stevers Software. All rights reserved.

Arabesque is a registered trademark and ECCO and the Shooter are trademarks of Arabesque Software Inc.

Windows is a trademark of Microsoft Corporation.

Registering
This software can be registered by filling out the registration form.

Registering will entitle you to the following benefits:
• allow you to keep using EC-Math beyond the 30 day trial period,
• a key that will disable the 'Please Register' dialog box,
• answers to your questions sent by mail and
• notices about future upgrades to EC-Math or other products that work with Ecco (if you've checked the 

appropriate boxes on your registration form).

Printed Manual
You may obtain a printed manual by printing the EC-Math.WRI document that was installed with EC-Math. This 
document contains the same information found in this help file.



Registration Form
(This topic can be printed using the Print Topic command from the File menu.)

EC-Math can be registered by filling out this form and sending it and a check or money order payable in US 
funds to:

Stevers Software
1011 West Lincoln Ave
Goshen, IN 46526

Name: _________________________________________

Company: _________________________________________

Address: _________________________________________

City, State, Zip: _________________________________________

Phone #: _________________________________________

EC-Math version: __________ (use the command Help|About EC-Math
to determine this)

Please check one of the following:

___ I wish to register 1 copy of EC-Math at $20
( Each person must fill out a registration form)

___ I wish to have a small site license and register    ___ copies of EC-Math at $15 per copy
(A small site license requires that at least 5 copies be registered)

___ I wish to have a large site license and register ___ copies of EC-Math at $10 per copy
(A large site license requires that at least 9 copies be registered)

Please check the following if appropriate:

___ Please notify me of any upgrades to EC-Math as they become available

___ Please notify me of other products that you develop for Ecco

___ I would be interested in a spell checker for Ecco

Other comments:



Quick Tour
This section is a quick guide to some of the features of EC-Math. The sample Ecco and EC-Math files are 
provided with EC-Math and have been copied on your computer if you chose to do so during the installation. 
You'll need the sample Ecco file for the tour.

Specifying an Ecco file

Define a Math Operation

Calculate Values

Find a New Folder

Conclusion



Specifying an Ecco file
The first thing you'll need to do in EC-Math is specify the Ecco file that contains the information you'll update. 
Do this by pressing the Define button (or pressing Alt-D). You will then see a dialog box where you can specify 
the Ecco file. Double click on EC-MATHS.ECO.

After the file is specified, EC-Math will load the file into Ecco. EC-Math will try to start Ecco if Ecco is not 
running. You'll have to start Ecco yourself if EC-Math is unable to start it. (See "Why can't EC-Math start Ecco" 
for an explanation.) EC-Math should report there are 41 folders in the file.



Define a Math Operation
If you were to look at the task view from Ecco, you would notice not all the detail hours are totaled up to the 
summary items. Our first math operation will total these numbers for us. Press the New button.

We want to total the Hours column values for items in the Tasks folder. Scan through the folder list box and find
the Tasks folder. You will have to select the checkmark folder type if the folder isn't listed. Click on the Tasks 
folder.

The next item to specify is the type of operation. We want to calculate the total in this case. Notice that Total is 
already selected. We'll add a different type of operation later.

The last item we'll specify is the column to operate on; in this case it is Hours. Click on the Hours column. You 
will have to select the number column type if the column isn't listed.

Your dialog box should now look something like this:

That's all. Press Enter or press the OK button to add the math operation.



Calculate Values
The Calculate button is now enabled since there is a math operation defined. Go ahead and press this button 
(or press F9) to have EC-Math update the values. You might see that three values were updated. Switch to 
Ecco to see the new information.

Another method of updating values is to click on the Calc icon ( ) on Ecco's title bar. Change the hours of 
'Fireplace brick' from 15 to 16 and click on this icon to have EC-Math update the hours of 'Do rough brickwork' 
from 45 to 46.

Switch back to EC-Math and define a new math operation that will find the minimum start date for items in 
folder Tasks. Before you press Enter or press the OK button, enter 'Task summary' in the 'Top level items 
summarized in item' box. Your dialog should look something like this:

Do the same thing to find the latest (maximum) finish date. Press OK and your main EC-Math screen should 
look something like this:



Press F9 and when you switch back to Ecco you'll find a new item in folder Tasks named 'Task summary' which
has the earliest start date and the latest end date. Before you play around with changing column values, 
change the Hours math operation to also put a total in this item (double click on the total hours math operation 
and put 'Task summary' in the 'Top level items summarized in item' box).

Switch back to Ecco and change some column values and click the Calc icon to have EC-Math update the 
summary values.



Find a New Folder
After working with the Ecco view, let's say you decide to track costs associated with each item. You'll have to 
add a new column, Costs, for this. Add this column in Ecco.

Switch back to EC-Math and add a new math operation that will total costs for items in folder Tasks. You can't 
do this because EC-Math doesn't show you a costs column. EC-Math does not know you added a new column;
you have to press F5 or choose the Edit|Reload folder list command. You should see the number of folders 
change from 41 to 42 after doing this. Now you can add the new math operation.



Conclusion
This concludes the quick tour. You can save the EC-Math information to a file if you wish, using the name EC-
MATHS.EC#. It should be the same as EC-MATH.EC# if you copied the sample files when you installed EC-
Math.

This tour didn't show all the functionality of EC-Math (it didn't cover averaging or finding the minimum or 
maximum value of text) but it should be enough to get you going.



Context Help
Menus:
        File Menu
        Edit Menu
        Configure Menu
        Help Menu
        System Menu

Main screen

Dialogs:
        About Dialog
        Define Math Operation
        Edit Math Operation
        Options Dialog
        Please Register Dialog
        Register Dialog

Keyboard Shortcuts



File Menu
This menu has commands that deal with loading and storing EC-Math information to a disk file. You should do 
this after defining math operations so you won't have to repeat the definition each time you run EC-Math. There
is also a command to end the program.

New Command
This command will erase the information in EC-Math. You will be given a chance to save the information before 
it is erased if it has not been saved since the last change.

Open Command
This command will load EC-Math information from a disk file previously saved from EC-Math. You will be given 
a chance to save the current information before it is erased if it has not been saved since the last change.

You may use Ctrl-O in place of this menu command.

Save Command
This command will save the current EC-Math information to a disk file that can later be used by the Open 
command. You will be asked for a name (as if you had chosen Save As instead of Save) if you have not yet 
saved the information.

You may use Ctrl-S in place of this menu command.

Save As Command
This command allows you to save the current EC-Math information with a new file name. This is also the 
command that is executed if you do a Save when EC-Math doesn't have a name for the file.

Exit Command
This command allows you to end EC-Math. This is the same as choosing the Close command from the System 
menu.

You may use Alt-X in place of this menu command.



Edit Menu
EC-Math's Edit menu is not like most Windows programs' Edit menu because you don't edit text in EC-Math. 
Because of this, you'll find commands that update values instead of text.

Reload Folder List Command
This command causes EC-Math to update its list of folders from Ecco. EC-Math has no way of knowing when 
you change folders or columns and relies on you to tell it when it's necessary to update its internal list.

You may use F5 in place of this menu command.

Calculate Command
This command causes EC-Math to query Ecco column values and update the values when necessary. 

You may use F9 in place of this menu command or, if you're in Ecco, click on the math symbol icon on Ecco's 
title bar.



Configure Menu
This menu has commands that allow you to customize the way EC-Math operates.

Change Options Command
This command displays a dialog box where you can enable or disable certain EC-Math features.

Refer to the Options Dialog for more information.

Register Command
This command displays a dialog box where you can enter your name and EC-Math registration key. The 
'Please Register' dialog box will no longer be displayed if you enter a valid key.

Refer to the Register Dialog for more information.



Help Menu
The Help menu allows you to access the on-line help for EC-Math and to view information about the version of 
EC-Math and Ecco's DDE. There are several different ways to get into the help system so there are several 
commands on the Help menu.

Contents
This command accesses the highest level of EC-Math help. From here you can branch to any level of detail 
you want.

Context
This command accesses help about EC-Math menus, dialog boxes, the main screen and shortcut keys.

Search
This command allows you to search EC-Math help by entering a word and seeing what topics may be relevant.

Getting Started
This command takes you to the help section that describes a sample EC-Math session. You may want to read 
through this help topic to get an overview of EC-Math features and how they work together with Ecco.

Common Questions
This command takes you to a list of frequently asked questions about EC-Math.

Using Help
This command gives you some tips on how to use the Windows Help system, including how to navigate and 
understand the various items on the screen.

About Ecco DDE
This command displays the Ecco DDE version. You'll be asked to supply the Ecco DDE version when you 
report a potential problem about EC-Math.

About EC-Math
This command displays the EC-Math version.



System Menu
This menu is a standard menu provided by Windows. Refer to your Windows manual if you want more 
information.

Restore Command
This command returns the window to the size it was before the last minimize or maximize command.

Move Command
This command allows you to move the window. You can also move the window by dragging the window's title 
bar.

Size Command
This command allows you to change the size of the EC-Math window. Please be aware that there's a limit to 
how small you can make the EC-Math window. This assures that the window is large enough to contain the 
necessary information. You can also change the size of the window by dragging on any window border.

Minimize Command
This command reduces the size of the EC-Math window to an icon at the bottom of the screen. The restore 
command will return the window to its previous size.

Maximize Command
This command changes the size of the EC-Math window to take up the entire screen. The restore command 
will return the window to its previous size.

Close Command
This command ends EC-Math. This is the same as choosing the Exit command from the file menu.

Switch To Command
This command allows you to switch to a different application.



Main Screen
There are many items on the main screen of EC-Math but it is designed to allow you to do most of your work 
from it.

Ecco File
This item identifies the Ecco file that EC-Math will update. EC-Math will make sure this file is loaded in Ecco 
when EC-Math asks Ecco for folder names and column values.

Number of Folders
This item simply tells you how many folders are stored in EC-Math. This can be used to verify that a new folder 
has been loaded into EC-Math when you press F5 or choose the Edit|Reload folder list command.

Math Operations
This item lists the current math operations defined over the Ecco file. You can add items to this list by pressing 
the New button, change items by selecting an item and pressing the Change button (or double clicking on an 
operation) and remove items by selecting an item and pressing the Delete button.

You can change the wording in this list box by checking or unchecking the Terse separator text on main 
window on the options dialog box. The item will change between "Total 'Hours' values in folder 'Projects'" and 
"Total 'Hours' in 'Projects'".

Define Button
This button allows you to define or change the Ecco file used by the math operations. This process will load the
file into Ecco if it is not in Ecco already. You will be required to change or delete existing math operations if you 
change the Ecco file and there are operations that use folders not in the new Ecco file.

Note that this process requires you to have saved the Ecco file to disk.

Calculate Button
This button causes EC-Math to calculate column values using the math operations listed on the main screen. 
This button is disabled until a math operation is defined.

You can also calculate column values by pressing F9 or clicking on the EC-Math icon on the Ecco title bar.

New Button
This button displays the Math Operation Dialog that allows you to define a math operation. This button is 
disabled until an Ecco file is defined.

Change Button
This button allows you to change an existing math operation. This button is disabled until a math operation is 
selected.

You can also change an operation by double clicking on a math operation.

Delete Button
This button allows you to delete an existing math operation. This button is disabled until a math operation is 
selected.

Status Line



The status line displays text that gives you some clue about the purpose of the item underneath the mouse 
arrow. The status line also keeps you informed as EC-Math is calculating column values and will display the 
number of values updated when the calculation is finished.



About Dialog
This dialog box displays the version of EC-Math that you're running along with the name entered on the 
registration dialog. The name will be 'Unregistered evaluation copy' if you haven't yet registered EC-Math.



Define Math Operation Dialog
This dialog box allows you to create or change a math operation. There are several pieces that define a math 
operation so there are several parts to the dialog box.

Items in Folder
This box lists the folders in the Ecco file. You should select a folder that contains the items that you want to 
summarize. All items in the folder will be summarized.

Folder Type
You can change the folders listed in the box by checking different items in the folder type group. Only folders 
that are a type that is checked will be displayed. You can select as many types as you wish.

Math Operation
This is where you choose the type of summary that will be performed. You can choose from average, weighted 
average, maximum, minimum or total. You can select only one operation.

Note that not all operations are valid for all column types. The following table lists the dependencies:
Operation Column type
Average Number
Weighted Avg Number
Maximum Any type
Minimum Any type
Total Number

Values in Column
This box identifies which column will be summarized. Please note the dependencies between the column type 
and math operation that is outlined in the table above.

Column Type
You can change the columns listed in the box by checking different items in the column type group. Only 
columns that are a type that is checked will be displayed. You can select as many types as you wish.

Top Level Items Summarized in Item
This box allows you to name an item that will contain a summary of other top level items in the folder. Ecco 
does not allow folders to contain column values so if you want to have a summary of all items EC-Math can 
place the summary in a separate item. Column values for this item are not used in future calculations.



Edit Operation Dialog
This dialog box is displayed when EC-Math's list of folders is updated and an operation uses a folder that no 
longer exists or has changed type. You will be required to change or delete the operation that uses the deleted 
or changed folder.

A specific example would be a math operation that totals the column Hours for items in folder Projects. If you 
delete column Hours from Ecco and reload the folder list from EC-Math, EC-Math will display this dialog 
informing you of the change you need to make to the math operation (since Hours is no longer a valid column).



Options Dialog
This dialog allows you to customize EC-Math to suit your preferences. Your settings will be saved from day to 
day so you won't have to save them each time you start EC-Math.

Terse separator text on main window
You can check this option to reduce the wording used by EC-Math in the math operation list box on the main 
screen. The separator text will change from 'values in folder' to 'in' (i.e. from "Total 'Hours' values in folder 
'Projects'" to "Total 'Hours' in 'Projects'") allowing you to choose clarity or brevity.

Display Calc icon on Ecco window

This setting allows you to enable or disable the Calc icon ( ) that is displayed on the Ecco title bar. The Calc 
icon gives you quick access to the calculation features of EC-Math without leaving Ecco.

Leave room for Shooter icon
This option will cause EC-Math to position the calculation icon over far enough to leave room for the Shooter 
icon. (You can always move the Calc icon if you wish.) You can uncheck this box if you don't use the Shooter.

This option is disabled unless the Display calc icon on Ecco window is checked.



Please Register Dialog
This dialog box is displayed until you register EC-Math. You have a 30 day trial period that you can use to 
evaluate EC-Math. After this period ends you should register EC-Math if you want to continue using it.

This dialog box cannot be closed and will periodically move around the screen while EC-Math is active.



Register Dialog
This dialog box allows you to register EC-Math after you have received a registration key from Stevers 
Software. The key is entered into the key field and you may enter any name you like in the name field. The 
'Please Register' dialog box will no longer be displayed after you have entered a valid key.



Keyboard Shortcuts
There are some keys you can press as an alternative to choosing a menu command or pressing a button:

F1 Help
F5 Reload folder list
F9 Calculate
Alt-X Exit EC-Math
Ctrl-O Open an existing EC-Math file
Ctrl-S Save current EC-Math information to disk



Common Questions
I'm trying to open file EC-MATHS.ECO as I'm told to in the Getting Started section but I don't see it. What do I 
do now?

I just added a new column (or folder) in Ecco but I can't find it in EC-Math. What's wrong?

How do I remove the dialog box that says 'Please Register'?

What is the icon with the math symbols on the Ecco title bar?

Why doesn't EC-Math start Ecco when I tell it to?

How do I add Ecco's directory to my computer's path statement?

Why can't I make the EC-Math window small?

How do I remove EC-Math from my computer?



I'm trying to open file EC-MATHS.ECO as I'm told to in the Getting Started section 
but I don't see it. What do I do now?
One of two things happened: either you didn't copy the sample files when you installed EC-Math or you're not 
looking at the directory where you installed EC-Math.

Here is an easy way to determine if you've installed the sample files:
• Start File Manager
• Choose Search from the File menu
• Enter EC-MATHS.ECO in the Search for box and make sure the Start from box looks like C:\, D:\, or E:\, 

and the Subdirectories box is checked. Then press Enter.

You'll need to install the sample files if File Manager doesn't find the file. If it does, you simply have to change 
to that directory to open the file into Ecco.



I just added a new column (or folder) in Ecco but I can't find it in EC-Math. What's 
wrong?
Nothing. The discrepancy is that EC-Math maintains its list of Ecco folders and doesn't know when you change 
the folders in Ecco. The only thing you have to do is press F5 (from EC-Math) or select the Edit|Reload folder 
list command to tell EC-Math to update its folder list.



How do I remove the dialog box that says 'Please Register'?
You need to register EC-Math by filling out the registration form and mailing it to Stevers Software. (Complete 
instructions are on the form.) 



What is the icon with the math symbols on the Ecco title bar?
This icon allows you to update column values without leaving Ecco (assuming you've already defined a set of 
math operations). You can click on the icon after you've changed some column values and you would like to 
see the results of your changes. Clicking on this icon is the same as pressing the Calculate button, pressing F9
or choosing the Edit|Calculate command (all from EC-Math).



Why doesn't EC-Math start Ecco when I tell it to?
EC-Math doesn't know in what directory Ecco is located on your computer's disk so it relies on that directory 
being in your path statement. EC-Math can't start Ecco if Ecco's directory is not one of the path directories.

You have two ways of avoiding this problem:
• always start Ecco before loading a file into EC-Math
• add Ecco's directory to your computer's path statement



How do I add Ecco's directory to my computer's path statement?
Follow these steps:
• Start Notepad and open the file C:\AUTOEXEC.BAT
• Find the line that starts with 'PATH='
• Go to the end of that line
• Add a semicolon (;) If the line doesn't already end with one
• Type the directory where Ecco is located (i.e. C:\ECCO). You can use File Manager to browse your disk if 

you don't know where Ecco is located.
• Save the file (choose the save option from the file menu) and exit Notepad

The path will be updated the next time you turn on or reboot your computer EC-Math should be able to start 
Ecco.



Why can't I make the EC-Math window small?
There is a limit to how small you can make the EC-Math window. This limit exists to ensure that the window is 
large enough to contain the controls needed.



How do I remove EC-Math from my computer?
You simply need to remove files that start with EC-Math. Here is one way of accomplishing this:
• Start File Manager
• Choose Search from the File menu
• Enter EC-Math*.* in the Search for box and make sure the Start from box looks like C:\, D:\, or E:\, and the 

Subdirectories box is checked. Then press Enter.
• Select all the files by pressing the shift key as you click on the last file
• Press the Delete key to remove all the files



Glossary
Average
Column
DDE
Double click
Dragging
File
Folder
Item
Math operation
Maximum
Minimum
Path
Shooter
System menu
Title bar
Total
Weighted average



Average
The average is a number obtained by taking the total of a set of numbers and dividing by the number of 
numbers. The average of 2, 7 and 6 is 5 (2 + 7 + 6 = 15; 15 / 3 = 5). An example as it might appear in Ecco 
would be:

Summary item 5
        Item 2
        Item 7
                Sub-item 9
                Sub-item 5
        Item 6

Note that the sub-item values are not used for this type of average. They are used for a weighted average.



Column
A column is a term used by Ecco to represent a place where you can enter values for items that are in a folder. 
It is these values that EC-Math updates for you.



DDE
This is an acronym of Dynamic Data Exchange. This is the method that EC-Math uses to communicate to 
Ecco. Using this, EC-Math is able to tell Ecco to load a file and can read and update the information displayed.



Double click
This is the process in which you click the left mouse button twice very quickly without moving the mouse.



Dragging
This is the process in which you click and hold the left mouse button down over an item and move the item to a 
different location before releasing the button.



File
This is used by computer programs to represent how information is stored on a disk. This is necessary because
information in memory is forgotten when the computer is turned off.



Folder
This is a way of grouping related items together. Folders can have a type of text, number, date, checkmark or 
pop-up list.



Item
This is a basic building block of Ecco. Items can have a parent and several children. Items can also have 
values in columns.



Math Operation
This is a definition in EC-Math that tells EC-Math how to summarize values in a particular column for items in a 
particular folder.



Maximum
The maximum is the largest value of a set of numbers or text. The maximum of 2, 7 and 6 is 7. The maximum 
of "Hello", "How are you" and "I'm fine" is "I'm fine" because "I" is after "H" in the alphabet. (Also "a" is after "Z" 
because the lower case letters start after the uppercase letters.) An example as it might appear in Ecco would 
be:

Summary item 9
        Item 2
        Item 9
                Sub-item 9
                Sub-item 5
        Item 6



Minimum
The minimum is the smallest value of a set of numbers or text. The minimum of 2, 7 and 6 is 2. The minimum of
"Hello", "How are you" and "I'm fine" is "Hello" because "e" is before "o" in the alphabet (the second letter is 
used since they both start with the same letter). (Also "Z" is before "a" because the upper case letters finish 
before the lowercase letters.) An example as it might appear in Ecco would be:

Summary item 2
        Item 2
        Item 5
                Sub-item 9
                Sub-item 5
        Item 6



Path
This is a series of directories which the computer searches when looking for a program to run. Each directory is
separated with a semicolon (;).



Shooter
This is a program supplied with Ecco that facilitates the sharing of information between Windows programs. 
The shooter can be started by clicking on the arrow icon on the title bar of the active window.



System Menu

This is a standard item for Windows programs that is activated by pressing the bar ( ) located at the upper 
left of the window. The active program can be closed by double clicking this icon.



Title Bar
The title bar is a standard part of Windows programs that contain the title of the program. The title bar may also
contain the Shooter icon or the EC-Math icon.



Total
The total is a number obtained by adding up all numbers in a set. The total of 2, 7 and 6 is 15. An example as it
might appear in Ecco would be:

Summary item 22
        Item 2
        Item 14
                Sub-item 9
                Sub-item 5
        Item 6



Weighted Average
The weighted average is similar to an average except for cases where a number is itself an average of two or 
more numbers (i.e. an item has detail items underneath it). In this case, the two or more numbers are used in 
place of the single number. An example as it might appear in Ecco would be:

Summary item 5.5
        Item 2
        Item 7
                Sub-item 9
                Sub-item 5
        Item 6

because 2 + 9 + 5 + 6 = 22 and 22 / 4 = 5.5 (the 9 + 5 is used in place of the 7 to give more importance to the 7
value).




